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Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION

without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Trademarks

Note the following:

AAWARNING

This device may only be used for the applications described in the catalog or the technical description and only
in connection with devices or components from other manufacturers which have been approved or
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage,
positioning and assembly as well as careful operation and maintenance.

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG A5E01031470B Copyright © Siemens AG 2007.
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Preface

Dear S7-200 user,

A programmable controller runs a control program that you create to solve most automation
tasks. The S7-200 Micro PLC can help you win the automation race to improve safety,
quality, and production speed while reducing project costs.

The S7-200 Micro PLC is being used for more and more applications because it combines
power with an attractive price and simple operation.

To make your first steps in the world of S7-200 as simple as possible, we have created a
special Starter Kit.

This Getting Started - Beginners is intended to teach you the basic skills to be able to use
the S7-200 within the shortest possible time.

And now, we wish you a simple and quick start and every success.

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B



Preface

Contents of the S7-200 starter kit

Item Quantity Available
S7-200 CPU 222 AC/DC/RLY

Input Simulator for CPU 222

Software: STEP 7-Micro/WIN V4

Output Simulator on mounting rail

PC/PPI Programming Cable (USB/RS 485)
S7-200 Documentation

Gelting Started - Beginners (including CD with programming
exercises)

Ala|lalalala|a

Screwdriver 1

Practice examples for the Getting Started - Beginners can be found on the STEP 7-
Micro/WIN documentation CD at: \English\Manuals\PrimerEx, or on your Programming
Exercises CD.

Safety guidelines

The Getting Started - Beginners is a quick introduction to the world of S7-200. It is not a
substitute for the S7-200 Programmable Controller System Manual. Therefore, you should
observe the instructions given in the S7-200 Programmable Controller System Manual,
especially the safety guidelines.

Getting Started - Beginners
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Installing the hardware 1

1.1 Assembly and Installation of the Hardware

Assembly and Installation of the Hardware
1. Attach the enclosed mounting rail on a base plate as shown here.

ﬁ‘

Mounting rail

Base plate

2. Attach the enclosed input simulator to the input terminal block located on the bottom of
the S7-200.

Output Simulator

Input Simulator

3. Attach the assembled S7-200 to the mounting rail.
4. Attach the output simulator to the mounting rail.

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B



Installing the hardware

1.2 Details of the S7-200 (CPU 222)

1.2 Details of the S7-200 (CPU 222)

Output
terminals

Power
Supply

o

Mode selector switch-

= STOP, TERM, RUN

Connector for
“=| expansion modules

-— 5 Analog
potentiometer

RS 485
Communications Port

Input
Terminals

24 VDC Sensor Power
Supply (180 mA)

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B



Installing the hardware

1.3 Wiring diagrams for the assembled hardware

1.3 Wiring diagrams for the assembled hardware

Wiring diagram for the assembled hardware

Connect the bold wires as shown in the diagram below. The gray wire is only mechanically
attached to the output simulator. Either end of the gray wire can be connected to L+ or 1L.

e -
1 Warning
: OUtpUt 1 Danger of injury
\ Simulator | and material damage.
=0 Ground (blue) 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 On/off Direction reversal 1 Power supply:
| (red) (black) I 8510264V AC/47to 63 Hz
1 1 Always connect PE !
gray | 1 L1
1 1 N
—l- 9 PE
3™ _-__-__-__-__-__l- r. |
1 O O 00 0 0OO0OO 00 X
1 1L Q0.0 01 0.2 0.3 PE N L1 |
1
! |
! 1
1
i S7-200 (CPU 222) :
1 6ES7 212-1BB23-0XB0 |
1
| !
1
1 10.0 01 0.2 03 2M 04 05 Sensor Power | I
I i) T i f j) T % i i) i) j) fsupply
s Bl C D I | o
1 J/ gray
1
Input Simulator M 7 blue

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B 9



Installing the hardware

1.3 Wiring diagrams for the assembled hardware

Circuit diagram for the assembled hardware

10

X Output X

1 Simulator 1

IC 1

! = + 1

! T 1

1 H 1

! 1

! ! 1

1 \' 1

[ 1

1 H 1

! 1

1 1

! 1

1 1

! 1 Power supply

: I 85to0 264 V AC/ 47 to 63 Hz

1 : Always connect PE !

1 1 L1

1

o o : N
g PE

(oo ©Q QO 0 0 0 O cL 00

Contacts of the internal PE
relay outputs

1L Q0.0 01 0.2 03

S7-200 CPU 222

6ES7 212-1BB23-0XB0

24 V inputs (input signals 0 to 24 V DC)

iM 100 01 0.2 03 2M 0.0

M L+ SensorPower

?::%:?::T::?::T::O?:g::oié:
/--r /--r /--r/--r /t /--I /--I /--r

1

1

Input !
P 1
1

Getting Started - Beginners
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Installing the hardware
1.3 Wiring diagrams for the assembled hardware

Wiring diagram of the S7-200 (CPU 222 AC/DC/RLY))

6 relay outputs Q0.0 to Q0.5

Power supply
(24 V DC/ 24 to 230 V AC max. 2 A)

(85 t0 264 V AC)

S

NN TN ISR Output side

i 0.0 01 02 ®

& N 1L

i 0.0 0.1 0.2 0.3 2M 0.4 0.5 M L+

OOOOOOOOOOO® | Inputside
SEERRRRRRR

Sensor Power Supply
24V DC/ 180 mA

8 inputs 0.0 to 10.7 (24 V DC) for sensors or expansion modules

|
+
1

CPU 222 AC/DC/RLY (AC Power/DC Inputs/Relay Outputs)

6ES7 212-1BB23-0XB0

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B
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Installing the software 2

2.1 Installing STEP 7-Micro/WIN for Getting Started - Beginners

In order to install the STEP 7-Micro/WIN V4 programming software you need a PC or
programming device (PG) with a Microsoft Operating System. The software will run on
Windows 2000 Service Pack 3 or later, Windows XP Home, or Windows XP Professional.

1. Insert the CD into your PC or PG that has Microsoft Operating System running.
2. Select the installation.

3. Start the installation wizard and follow the instructions.

(7% Seleot the languags for this installation from
 the choices below.

[Engiih

French [Standard)
German

Italian

bickd Wizaid lin STEF Spanish

Wieleome 1 the InatalfS)
7 MicsoWIN V404 16

Hed Careel

Note: If you have a previous version of STEP 7-Micro/WIN installed, you will be prompted to
remove the old software and reboot your system. After the old software is removed, open
and close the CD drive to restart the installation process.

At the end of the installation, the entry, "STEP 7-Micro/WIN" appears in the Windows Start
menu, Start > SIMATIC.

Getting Started - Beginners
Training Documents, 07/2007, ASE01031470B 13



Installing the software
2.2 Starting STEP 7-Micro/WIN

2.2 Starting STEP 7-Micro/WIN

From the Windows Start menu, select the SIMATIC > STEP 7-Micro/WIN V4.0.x.xx >
STEP 7-Micro/WIN to start the STEP7-Micro/WIN programming software.

¥) Hepand Support

—] Bun.

_J Log Off Fraereh...

(0] ShutDoen..

0d| Windows XP Professional

I Stan -

s

Getting Started - Beginners
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Installing the software

2.3 Using the Help system

2.3 Using the Help system

The Help window tabs, Contents, Index, and Find (full text search) help you find a topic
starting with a view of all Help topics.

Select a menu item, or open a dialog box, for which you want help and press the "F1" key to
access the context-sensitive help for that item.

What's This? Help provides definitions of interface elements. You can also access What's
This? Help by pressing the shift and F1 keys simultaneously. The cursor changes to a

question mark; use it to click on the item for which you want help.

If your computer has access to the Internet you can download or retrieve information about
SIMATIC S7-200 hardware and software using the S7-200 on the Web menu item in the
Help menu.

Help Topics: STEP 7 - Micro/wIH Help

Conterts Index | Find | 1 Contents and Index

Getting Started - Beginners

ESTEP 7-Micro/WIN - Project]
File Edit “iew PLC Debug Tools Windows Hel

NE@|eh|s=r

NAEEEEE

What's New
B CPU 221 REL 0110
H Program Block
(=] Symbol Table
(] Status Chart
H Dats Block
System Block

EEEEEgr s 21

1 Type the first few letters of the word you're looking for. 1

2 Click the index entry wau want, and then click Display.

30 o1 Flat Bultons !

Training Documents, 07/2007, A5E01031470B
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ork 1 Netwark Title

Contents and |ndex
What's This? Shift+F1

S57-200 on the web

Help

What's This? Shift+F1
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57-200 Produ
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Basic settings 3

3.1 Connecting the communication cable

The PC/PPI Programming Cable (USB/RS 485) connects a PC to the S7-200 PLC.

On your PC, use a standard Universal Serial Bus (USB) peripheral connector. Connect the
USB/PPI cable to the PC and to the PLC.

Supply the PLC with the operating voltage.
The STOP or RUN LED should be illuminated.

PG/PC §7-200 CPU

USB port

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B 17



Basic settings

3.2 Configuring the S7-200 communication

3.2

18

Configuring the S7-200 communication

1. Click the communications icon in the navigation bar.

2. Review the communications settings.

3. Double-click the corresponding field to refresh. The connected CPU should now be

recognized and registered automatically.

. If the CPU is not recognized, or if a pop-up window tells you that communication is not

possible, double-click the field PC/PPI cable.

5. Select PC/PPI cable in the Set PG/PC Interface dialog and select Properties.
6. In the PPI tab, set the station address to 0 and set the transmission rate to 9.6 kbps. In

the Local Connection tab, select the USB port. Click OK to confirm all settings and close
the Properties dialog. Click OK to close the Set PG/PC Interface dialog. Note that the
station address cannot be the same number as the CPU address.

. Double-click the corresponding field in the communications field to refresh. The CPU will

now be recognized and registered automatically. The process could take a few seconds.
Now click OK to close the Communications dialog.

FJSTEF 7-Micio/WIN - Projectl

File

Edit “iew PFLC Debug Took ‘Windows

NE@|@h| s Ee| oL

ho e B[R] o % % % ¥

Asces Puth |

Accans Pont of the Applestion:

Project!

£ (] Instructions

H Favorites
Bit Logic

(<] Compare

Counters
Floating-Faint bath
it "teger Math

Pt

i
;\h\\mzj\ Operations

Fragram Cantrol
) Shift/Rotate
Stiing

EEE

-

(Standand foe Micra AWIN]

Indend o P v B Lot

Getting Started - Beginners
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Basic settings
3.3 Performing the first function test

3.3 Performing the first function test

To perform the first function test, follow the steps below:

1. Set the mode selector of the PLC to the TERM or RUN position. The mode selector is
located behind the small cover at the front side of the CPU.
Note that remote control of the operating mode (RUN or STOP) is possible only in the
TERM or RUN position.

2. From the PC, switch the S7-200 to STOP mode and back to RUN.
The green RUN LED on the PLC lights up in RUN mode. The yellow STOP LED on the
PLC lights up in STOP mode. If you can switch the PLC operating modes from the PC,
the connection between the PC and PLC is configured correctly.
If the mode does not change, check the connecting cable between the PC and PLC and
the communication settings within STEP 7-Micro/WIN.

1.

LED SF/DIAG
LED RUN
LED STOP

PC /PPl cableto — 71

the PC

=lelx

Fie Edt View PLC Debug Tock Windows Help
O 80| LtmR o D ax|wer
e [ AR A% B = 2

STOP

N?) Place the PLC in RUN mode? 3) Place the PLC in STOP mode?

Mo Mo

Getting Started - Beginners
Training Documents, 07/2007, ASE01031470B 19






First programming exercise

4.1 Writing your first program

Great, the first functionality test has been successfully
performed. The controller is up and running, and the
communication to the PLC works.

But how do | write a program?

Now you will quickly learn how to program the
basic functions of the PLC in small steps using
the exercise program on the enclosed CD.

First of all, you will learn how to
open an exercise program from
the CD and transfer it to the PLC
with the STEP 7-Micro/WIN
programming software.

After that, you will familiarize
yourself with the function of
the program you have
transferred.

_

With basic knowledge about “logic —

operations” you will be able to
analyze the elements of exercise
program 1 and understand the
statements in it.

__
—
In the Section “More Exercises” you will
learn the important knowledge you
require to write your own programs by
changing the exercise program.

/

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B



First programming exercise

4.2 Opening the first programming exercise

4.2

22

Opening the first programming exercise

CD-ROM Drive

1. Insert the Programming Exercises CD into the CD ROM drive of your PC. This
CD is located in the envelope on the last page of this manual.

\,

=5 ( EP 7-Micro/WIN - Project1

File Edit Wiew PLC Debug Took Windows Help

élﬂ\@@\

Tew Chri+h
Open... TG
Close

Save Chrl+s

Save As...

Set Password, ..

Open [ 2x
Lok in: | Programing Exer (T:) v & @ e FE-

1h_pr_de.mwp

Import, .
Export, .
Upload... Tkl
Download. .. cuhto

—_
th_pr_es.mwp
1h_pr_fr.mwp

Create Library...
Add/Remove Libraries...
Library Memory. .

< —

Files of type: | Froject Fies ")

j Cancel

2|

2. To open the first programming exercise, select File > Open. From the Open window, look in the
CD ROM and open the STEP 7-Micro/WIN project with the appropriate language

(for example, for English: 1hr_pr_en.mwp).

STEP 7-Micro/WIN has now loaded the
programming exercise into the working memory
of the PC and displays the first steps of the
exercise program in the program editor.

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B



First programming exercise
4.3 Downloading the first exercise program to the CPU

4.3 Downloading the first exercise program to the CPU

@STEP 7-Micro/WIN - 1h_pr_en
File Edit View PLC Debug Tools ‘Window: ''-'-

NEd|sh|ine| - &

S

TN =

c

I - R

Symbol | War Tupe | Data Type \
[TEMP [

yo®
AR AR

g

System Block.
Crozs Reference

Communications
[ Wizards
q’ Tools
B3] Instructions
(] Favoites

It is only possible to
transfer a program to the
S$7-200 in STOP mode!

Fiarcte Addracs 2 CPU 220 REL 0200

“i) ek Dowarlond b bage, A%"‘—'

-
[ Ophens £ — r t, E‘,‘S’tndli-‘-‘.\
o AT R T AN
oo o =
7 Syitan Dlock To:PLE ‘-’-r l\’é‘Q
B>

Runtime edits are available on the CPU 224, CPU 224XP and CPU 226. Runtime edits allow
program edits while in RUN mode.

You can download the program by following these steps:

With the mode selector in TERM or RUN position, click the Download icon.
| :l The project is automatically compiled. If there are no errors in the project, a
window appears to prompt you to put the PLC in STOP mode.

Click the OK button in this window to put the PLC in STOP mode. The project is then
downloaded to the PLC.

Once the project has been successfully downloaded to the PLC, a window appears to

prompt you to put the PLC back in RUN mode. Click the YES button to put the PLC back in
RUN mode.

You can also load a program from the PLC onto your programming device/PC.

Click the Upload icon to upload the program from the PLC to the

: | programming device/PC. It overwrites the program currently displayed on the
PC display. Therefore, you should ensure that you always have a current
version of your program saved on your PC.

Getting Started - Beginners
Training Documents, 07/2007, ASE01031470B 23



First programming exercise
4.4 Function and Test of the first exercise program

4.4 Function and Test of the first exercise program

|n the f|rSt eXerCise program, SW|tCh SO tUI'nS 24 V DC from Sensor the Power Supply
the motor on and off. Switch S1 changes the | > onnesrznces
direction of the motor.

Switches S0 and S1 are the first two
switches on the input simulator. These
switches provide 24 V DC to inputs 10.0 and
10.1 on the CPU. The output simulator is
connected to Q0.0 and Q0.1 on the CPU.
Q0.0 turns the motor on and off. Q0.1
changes the direction of the motor.

With the exercise program, the signal state
of 10.0 is assigned to output Q0.0 and the
signal state of 10.1 is assigned to Q0.1

0V DC from the Sensor Power Supply on the S7-200 CPU

Now let's test it! \
The operating voltage is

connected to the CPU. The
assembly is wired correctly. You
have opened the program exercise
from the CD and downloaded it to
the CPU. The CPU is in RUN

mode (the green RUN LED is on).
Now operate switches SO and S1

and monitor the results.

Switches S0, S1, S2, ... Input Simulator

Actions Reactions

Switch SO operated LED 10.0 is on LED Q0.0 is on Motor turns
Switch SO & S1 LEDs 10.0 & 10.1 LEDs Q0.0 & Q0.1 Motors turns in the
operated are on are on opposite direction

LEDs 10.0 to 10.7 indicate the signal states
of inputs 10.0 to 10.7.

LEDs Q0.0 to Q0.5 indicate the signal
states of outputs Q0.0 to Q0.5.

I and Q are the customary international
symbols for inputs and outputs (10.0 Q0.0).

Getting Started - Beginners
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First programming exercise

4.5

Elements of ladder logic (LAD)

4.5 Elements of ladder logic (LAD)

0 and 1 are the only data states in digital control logic. The 0 state is designated as false and

the 1 state is true. This is why we say a PLC scan is either O (false) or 1 (true).

Schematic
diagram elements

PLC scan
logic elements

PLC program
ladder diagram elements

—_— —
—

Positive logic
Input sensor scan

Is current flowing?
If yes, then the result
of the scan is true
(Result is1)

—

Negative logic
Input sensor scan:

Is no current flowing?
If yes (no current), then the
result of the scan is true
(Result is 0)

1/

Output Coil:

If the value “true” (current) is
passed to a coil
it is activated
(The coil is ON)

—

Series circuit connection
(AND logic)

The first switch AND the
second switch must be closed
in order to pass current

+HH

—3

Parallel circuit connection
(OR logic )

The first switch OR the second
switch must be closed in order
to pass current

T

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B
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First programming exercise

4.6 Transforming a circuit diagram

4.6 Transforming a circuit diagram

How do you transform a circuit diagram into a PLC program? Rotate your circuit diagram 90°
to the left. Your power rail will then appear on the left, with the grounding rail on the right. In
the middle you will see the switching elements of your circuit. The circuit logic of a machine
(e.g. time relays or flip-flops) which used to be implemented by wiring together switches,
auxiliary contactors and control contactors, etc., is now handled by the PLC. Control
elements such as input switches, selector switches, etc. on the input side, and power
contactors (such as motor contactors, polarity reversers, valves, etc.) on the output side
cannot be replaced by the PLC.

£T0q ‘/Qon
¢ - )

Change in direction of
rotation: Switch S1 is

Motor ON / OFF:
Switch S0 is connected to

connected to input 10.1 of 10.0 Q0.0 ;

. . . input 10.0. In our example,
the PLC. Contactor K1 is
activated by output relay |_( ) Eon;?_(éoc;ufouﬁ;:e (rleg lgced
Q0.1 inside the PLC. Y p y MO.D.

Getting Started - Beginners
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First programming exercise
4.7 Elements of the first exercise program

4.7 Elements of the first exercise program

Let’'s have a closer look at the structure of the PLC program in a ladder diagram (LAD).This
type of representation closely resembles a circuit diagram.

Ladder diagram of program 1h_pr_en.mwp This is a network

Motor comment. It is used
>  on/off as a title for the
] network.

Hetwork 1 Motor anioff —-
10.1 B
Q01 N» This field is used to
—| \P- J etwor number and separate

the networks.

Hetwork 2 Change of rotat. direction - 100 This contact is
active when input
10.1 Q0.1 | | 10.0 passes current.

q\ Q0.1 This coil / output is
> active when the
—( )— switch ahead of it
\ (here: 10.1) is closed.

| Power rail |
Networks are used to structure a
program. You insert a current
path into each network.
STL program FBD program

NETWORK Hetwork 1 bator ondoff - On= 5w

LD  10.0 [ ] Q0.1

= Qoo o4 =]

NETWORK Hetwork 2 Change of rotat. direction

LD 10.1

_ Q0.1 Q0.1

' o1 = 1]

Getting Started - Beginners
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First programming exercise

4.8 Status view (online)

4.8

28

Status view (online)

Select the menu item Debug > Start
Program Status to activate the status view
of the ladder diagram.

You can now view the status of the
operands in the PLC.

In the example, switch SO is connected to
input 10.0.

If you now actuate the switch and observe
the program in ladder status view, the
operations which are passing current
(true) are filled in blue.

The status of the operations is read
cyclically from the PLC and updated on
the screen.

In this context, online means looking
inside the controller with a PC/
programming device to view the current
states and their cyclic changes.

Debug Tool: 'windows Help

First Scan
Multiple Scanz...

Start Program Status

" w Usze Ezecution Status

Start Chart Status

Single Read

Unfarce Al

Wiite-Force Outputs in STOP

10.0

10.0

—

Hetwork 1 Motar anfoff - On = Switc

| il

/ Hetwork 2 Change of rotat. direction -

Q0.0

Q0.0

)

Very fast events cannot be tracked in this way because the time required to transfer the
data to the screen is too long. A status view is also possible for a function block diagram

(FBD).

Getting Started - Beginners
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First programming exercise

4.9

Statements

Control Statements

The control statement is the smallest unit of a PLC user program. A statement consists of two

parts.

Operation

Operand

(Do what?)

The operation of a statement determines
the function that is performed when the
control statement is executed.

In this case, the LAD diagram element is
a normally open contact switch that
passes current when active. If this contact
switch is connected in series with another
contact, then the two contacts perform a
logical AND operation.

If this contact switch is connected in
parallel with another contact, then the two
contacts perform a logical OR operation.

(... to what?)

The operand of a statement (in this case input
0.0) specifies inputs and outputs for the control
statement. It consists of an operand identifier and
a parameter.

\

| Parameter

Operand identifier

The operand identifier The parameter is the
specifies an area of the address of the

PLC. In the above example, | operand. It consists
an operation is performed of, a byte and bit

on an input. Other areas address.

include outputs and bit

memories.

4.9 Statements

Structure of an operand

| I— Bit address:

Decimal point:
Byte address:

bit number in the byte (0 to 7)

separates byte address & bit number

Number of a group of 8 bits

Operand identifier

(area identifier)
Possible areas:

inputs, outputs,
Internal bit memories, special
memories, variable memories

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B
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More exercises

5.1 First program modification

5.1.1 AND logic operation

Objective: Switch S2 and switch SO must be
closed to switch on the fan motor.

As before, switch S1 is closed to reverse the
direction of rotation of the fan motor.
A description of the function shown above:

The motor runs when SO AND S2 are
closed. In ladder diagram that means:
when contacts 0.0 AND 10.2 are closed,

current flows from the power rail to coil Q0.0.

expressed as follows:

| | AND logic operation >

We do not need to wire switch S2, since it is
already connected to input 10.2 via the
simulator. The next page describes how to
select, insert, and delete a logic gate, and
how to name the operands.

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B
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!

SO
Fom

S2
Fom

—_—

l"v\ S1

kol

| @

Circuit without PLC
The contacts are connected in series (AND logic). In the ladder program, the logic is

Hetwork 1
10.0

Hetwork 2
10.0

>

— = )

Maotor ondoff - On o= Switch 10.0 On,
10.2 Q0.0

Change of rotat, direction - Direction
Q0.1

Ladder diagram of the circuit
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5.1 First program modification

5.1.2 Inserting a logic gate

If you want to connect a further normally-open contact for input 10.2 in series between
normally-open contact 10.0 and coil Q0.0 (i.e. insert an AND link between 10.0 and 10.2),
you first need to select a valid location to put the new contact.

Click the next element to the right of the Network 1 Hotor C'”’JC'CZFO -
10,0 .

insert point. In this case, put the selector box |

on coil QV.0. | || ¢ ) \i\f’
>

The insert point will be to the left of the
selector box.

Click the contact button in the tool bar or
press the corresponding function key.

Select the type of contact from the drop list. | Netwerk 1

Choose top item of the list. This is the | 10.0 |
normally-open contact. 1 I

Hetwork 2
101

Network 3

Getting Started - Beginners
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5.1 First program modiification

51.3 Entering the operand and testing

After you insert the new contact, you must specify the correct operand.
Click the operand field and then input the operand: 10.2.
Press the Enter key to confirm the input.

Don’t forget to save your changes! ﬁi

Hetwork 1 Motor andoff - On o= Switch
10.0 Q0.0

_|

Click the field with the mouse at any time to
select it again.

Hetwork 2 Change of rotat, direction -
101 Q01

— — )

If you want to test a modification:

Download the modifications to the PLC and
test the program. Actuate switches SO and
S2 to start the motor.

View your program in ladder status mode
and observe the switch state change
displayed in the ladder diagram.

w

—_—
Debug Tools Windows Help

| First S

Getting Started - Beginners
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5.1 First program modification

514 Deleting a contact or an operand
If you want to delete the 10.2 contact, select the contact with the mouse and press the DEL
key.
You must reconnect 10.0 to Q0.0 by clicking the Line Right button.
=
Hetwork 1 Motor ondoff - Cn= Switch 100 O ‘ j-l_fli—l—bl -ll-l-()lﬂl|
10.0 10.2 Q0.0
) ~ f|Line Right]
Hetwork 2 Change of rotat. direction - Directi
10.1 Q0.1 S
Hetwork 1 Motor ansoff on = Switch 0.0
— () 10.0 Q0.0
— > )
Hetwork 2 Change of ratst. direction - Dires
10.1 Qo1 Hetwork Motor ondoft - On = Switch 10,000,
— - ) 10.0 Q0.0
H )
Hetwork 2 Change of rofat. direction - Direction
101 Q0.1
— — >
File | Edit ¥iew PLC Debug Tool: Windows  |f you want to delete a selection, row,
a Unda Chl+Z || El 'ﬂl E column, vertical, network(s) or POU proceed
= — as follows:
4t i,
E [Capy [l |%|%| ﬂl ﬁlfi . .
E : Chleid Select the desired object.
IEGBIE 1i:e _pr_eh [C:ADocuments . .
Select &)l Chil+d, What's New Open the Delete menu by selecting Edit >
| CPU ZIGREL 010z Delete.
rizert L s
Selection
.
Find... Chil+F Columin
Replace... Chl+H =
GoTo..  Chl+G wertical
B MHetwork[z] Shift+F3
..... Ll
Getting Started - Beginners
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5.2 Second modification fto the program

5.2 Second modification to the program

5.21 OR logic operation

Objective: *
Switches S0 and S2 are to be actuated in

—
—e
—

order to switch on the motor. Switch S3 e e Ko
alone is to be used as an alternative in order

to switch on the motor. Switch S1 is to be 1

used to reverse the direction of rotation of < l-\

the motor. k.~

| N €)

Circuit without PLC

A description of the function shown above:

When (SO AND S2) OR S3 are actuated, the motor runs. In the ladder diagram that means:
when contacts 10.0 AND 10.2 or 10.3 are closed, current flows from the power rail to coil
QO0.0. This is a parallel connection from S0 and S2 to S3 (OR logic operation). In our
program, the logic is expressed as follows:

Hetwork 1 Matar onfaft - On= Switch 10
10.0 10.2 Q0.0

We do not need to wire switch S3, since it is ‘b

already connected to input 10.3 via the
simulator. The next page describes how to
select and insert an OR logic gate with a Hetwork2  Change of rotat. dirsction - Dir
connecting line. 101 Qo1

— < )

Ladder diagram of the circuit

Getting Started - Beginners
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5.2 Second modification to the program

5.2.2

36

Inserting an OR element

Use the mouse to select a free
position in the same network and
insert a normally-open contact at this
location.

Click the mouse on the Line Up
button in the LAD toolbar

Now the parallel OR branch is
complete.

Metwork 1 kdabar ondoff

10.0

—

Q0.0

)

. W

<

TLmd—l—rl -||-|{)|‘I:||
~
e e s 2

3...

>

3| ||| 10| O]

— )

L T T - L T B
Metwork 1 Motor ondoff - On = Switch 100 On,
10.0 10.2 Q0.0
| | | | r
I 1 I b )
10.3
_| |
I
Metwork 2 Change of rotat. direction - Direction
10.1 Q0.1

Q0.0

4

4

Metwork 1 P abor ondoff O = Switch 10.0 0
10.0 10.2
| | | l r
| | | | Yo
10.3

Getting Started - Beginners
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5.3 Third modification fo the program

5.3 Third modification to the program

5.3.1 On-delay timer

Objective: —b ° . ° °
In the following program modification, you [ I [ ] I
insert an on-delay timer in exercise FAS \ R AS Y Ko
program 1.

When input 10.3 (S3) is activated on the
simulator, a waiting time is started.
Output Q0.0, and thus the motor, is not
activated until the waiting time has
expired.

s2
.~

K1

el =Rl O

Circuit without PLC

No wiring work on the PLC is required for
the additional timer function.

All necessary switches and actuators are Metwork 1 1 second ime delay timer
already wired. The timer relay is replaced started by 10.3 switch contact
by a PLC timer function.

The following page introduces the
on-delay timer function of the S7-200.
We will add a time delay network and
create this three network program.

Metwork 2 Motor ondoff - On = Switch [0.0 On,

£l
- 10.0 10.2 Q0.1
¥ | | | | r
| | I L )
T34
| l
1 |
Metwork 3 Change of rotat, direction - Direction
101 Q0.1

— ——

Ladder diagram of the circuit

Getting Started - Beginners
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5.3 Third modification fo the program

5.3.2 Understanding the on-delay timer function

Network 1 1 second time delay timer
started by 10,3 switch contact

You require an on-delay
of 1s. The S7-200
CPU222 has 256 timers.
The timers have the
designations TO to T255.
Use T34 in this example.

03 s

1M TON

Before the timer
will run, it must
be started. In our
example, this is
done with 10.3 at
the input “IN”.

Set the time value of 1s by writing the
value 100 to PT. The time value is
calculated from the factor PT (here 100)
and the timebase of the timer. (T34 has a
timebase of 10 ms,100 x 10 ms = 1s).

Timebase Tx

fms 70,732,764, T9 ﬂ/ery timer in the S7-200 has a

10ms  T1-T4, T33-T36, T65-68, T97-T100 status bit (time elapsed/not

100ms  T5-T31, T37-T63, T69-95, T101-T255 elapsed). This bit is called the
timer bit. For the timer T34, it is
called T34.

Input 10.3 must have the value

“1” that is 1s, before timer bit T34
is “1”. If the delay has not elapsed
For CPU 222, timers when the enable signal “IN” is
with timebases of 1 canceled, the timer is set to “0” and
ms, 10 ms and 100 ms the timer bit is not set (see the
are available. Timers timing chart below). You can use
can only be used once. the timer bit like contact operands.

L

IN e.g.10.3
A
5— ———————
PT=5 o
ie. 3Jf—-—=——=---
5x10ms of === ==== | ——
inT34 L _ _____
Txx e.g. T34
Ol withbase 10ms | 1 11 \ |
o 1! 1 1
1'0 ms 1 ! !
_i3‘i_ Timer bit of T34 1“ ! !
1T 1 1
! s

Timing chart for a time value of 50 ms

Getting Started - Beginners
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5.3.3

Programming the on-delay timer

Using the Toolbar

| sles] oloe[e] % |

-Il—l—()l‘l:ll

Getting Started - Beginners

TOMNR E
TRUNC -~
WAND_B &=

AT DAY

VAN DY hd

Metwork 2

10.0

I NN - | S
Metwork 1 1 second time delay timer
started by [0. 3 switch contact
10.3
| |
1 | >
Metwork 2 F atiar ondaff O =Switch [0.00n, Q1
10.0 10.2 Q0.0
| | | 1 rd
1 | 1 I | ~ )
SHR_W " Metwnrk 1 1 second time delay timer
| _[SHRB | started by 10.3 switch contact
SQRT 3 o
suB_DI g —
U ) —m TON
SUB_R
ShWAP FT 277 ms|
TBL_FIMD
TOF

otor ondoff On = Switch 10.0 On,
10.2 Q0.0

| | ¢ )

5.3 Third modification fo the program

. To evaluate a timer contact

inserted in our OR logic
network, you must create that
timer box in a previous
network. Select a part of the
first network with a mouse click.

. Insert a normally-open

contact for input 10.3 in the
first column of the new
network 1. Then put a timer
in the second column as a
on-delay timer type. Select

. Then, put a timer in the second

column as a on-delay timer box.
Select the Box-F9 tool bar
button.Scroll down until the
function TON (on-delay timer)

. Select the fields for PT and

TON and input your values, in
this case 100 and T34.

. In the last step, the timer bit

T34 must now appear in
network 2 in the position of
10.3. Make the correction.

Save the program and
download it to the PLC and

Training Documents, 07/2007, A5E01031470B
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5.4 Working with projects

5.4

541

40

Working with projects

Programming with symbols

So far you have been working in the PLC program with operands in the "PLC language"
such as 10.3 or T34, but if the program is longer, it is not easy to associate these operands
with their actual function within a control system. The program would be easier to read if we
could switch the operand names to plain text. This is exactly what you can do with symbolic

programming.

[=E/STEP 7Micro

File Edit “iew P

1. For symbolic addressing, the symbol table
must be filled in. Select the symbol table
from the Navigation bar, Instruction tree, or
select View > Component > Symbol table.

MicroWIN - Th_pr_en

ieww PLC Debug Tools ‘Windows Help

Frogram Block v Ladder
nbol T able; ® EED

B el e | o e
EII% 4 %l%lﬂ f,lls.t,.m ﬂ’!T;rLELE Debug Toaols Windows Help

£F 5vM1

A POU Syrabolz
|G Status Chart
Diata Block

v Symbolic Addressing Chil+v

Status Ch
Symbol Table ) I

System Block Data Block
; EJ Cross Reference 7 v Symbol Information Table Ctel+T System Black
i POU Carmments Cross Reference
Metwark Comments Communications

Toolbars 3

Set PGAPC Interface

Ll

|_

e D Network 1
A . 10.0
Bookmarks

t I N N T N - O |

o |2 Symbal Addiess Comment

1 50 10.0 Switch

2 51 10.1 Swiitch 1

3 52 10.2 Switch 2

4 53 10.3 Switch 3

] tdator_OM Q0.0 Tumsz motor OM

[ Direction Q0.1 Changes the direction of the matar

7 Delay 13 T34 Waits 100 & 10ms = 1 second

g

]

2. Awindow is displayed in which you can edit the symbol table. Enter the name that you
want to appear as plain text later on under “Symbol”. Under “Address”, enter the operand
that you want to have associated with the symbolic name. Under “Comment”, you can
enter any text that you find helpful. Don’t forget to save your work.

[
Continued on next page
u

Getting Started - Beginners
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Using a symbol in a network

ESTEP F-Micro™WIN - Th_pr_en_fix

Eil=  Edit | Wiew PLC Debug Tools ‘window:

STL
v Ladder
FED

POU Comments

Metwork Comments

5.4 Working with projects

3. Select the menu item

View > Symbolic Addressing

to switch the display mode. If the
Symbol Information table entry is
also checked, you can see a
symbol summary table at the
bottom af each network.

4. If you have selected symbolic

addressing and changed to LAD,

Toalhars [J STL or FBD, the symbolic addresses
Frame 3 should now be visible. You can also
Bookmark R switch the Symbolic Addressing
Dookmans checkmark off and on again to
Properties...
Metwork 1 1 zecond tirme delay timer
i started by 10.3 switch contact
S3:10.3 Delay_1s:T34
| |
IM TOM
) .
+1004PT 10ms
Symbal Address Comment
Delay 1z T34 Wiaitz 100 # 10z = 1 second
53 10.3 Switch 3
Hetwork 2 kM atar andaff Or = Swaitch [0.0 On, O = Switch 10.0 OFf
S0:10.0 S2:10.2 Motor_ON:Q0.0
| | | | r )
| 1 | b
Delap 12T34
|

5. The figure above shows the ladder diagram of the user program with symbolic
addressing. You can, of course, also program with symbolic addresses.
As the operand, you must then enter “S3”, for example, you only have to make
sure that this operand has already been entered in the symbol table.

Getting Started - Beginners
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5.4 Working with projects

542 Creating a new project

If you want to write a new program of your own, you need a sort of container to put your
program file in. In STEP 7-Micro/WIN, this container is the project. An S7-200 project
contains all additional information for your project, for example, the symbol table and
comments etc.

Open...

Cloze
- 3

Save
Save fs... \

Ctrl+0

_—

Set Pazsword...

Import....
Expot...

1. Create a new project with menu
command File > New .

now.

2. The result is a project with the name
Project1. You can start programming

ESTEP T-Micro/WIN - Project]

File Edit “iew PLC Debug Taols

Wwiindows  Help

Olzl@] sl slelel of mel al=] ol 2| =] =

See the next page
for more.

42

o] L] el%l%[s] Flon| ~[ole[+] 1e]oln]|
Wiew E@ Praject] I
g E"Ptla;;#:l: FeL o200 Sl TE\::F" Tvpe
E= #-[gg Progiam Block TEHP
(2] Symbol Table TR
(I Status Chart TEMP

B
£
[
B
B
[ Cross Reference
[ % Comrrunications
L
B
£

(g3 [ata Block
0B System Block

i) Wizards

]--ﬁ Tools

(3] Instructions

-3 Favortes

3} Bit Logic

#-[] Clock.

- £] Communications
-] Compare

(25 Cornwert

t-[41] Counters

Network 1 Metwork Tithe

3

Network 2

3

Getting Started - Beginners
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5.4 Working with projects

Save the project under a new name

FYSTEP 7-Micro/WIN - Project] 3. Save Projectt immediately, after, or
= - - during programming under a name that
File Edit “iew PLC Debug Toc means something to you.
New Ltk Select the menu File > Save As to open
Open... Ctrl+0 the dialog box.
Cloze
Save Ctrl+5

Set Passwurc\l\ -

Impoit. %
Export...
4 . In this box, give a name to your
project and select the hard disk drive and
the path/folder where you want to store
your project.
savens olxl Terminate your input with Save.
Savein I_) Projects - E‘F EE-

File name: IFm\acH mp

Save as type: IPrDiEC[ File [".rmwp)

After these steps, you have now created a new
project with a new program file. You can now
create your new program.

Getting Started - Beginners
Training Documents, 07/2007, A5E01031470B
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5.4 Working with projects

44

the SIMATIC S7-200 in your
automation projects.

If you want to learn more, you will
find useful information in the
appendix.

/Congratulations, you can now use \

_/

Getting Started - Beginners
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5.5 Do you want to learn more?

5.5 Do you want to learn more?

You will find more examples in the "Samples" directory in your STEP 7-Micro/WIN directory.

The examples of the Getting Started - Beginners are continued in the Getting Started -
Advanced.

In addition, a CD ROM with "Tips & Tricks" for the S7-200 is available. You can obtain the
Getting Started - Advanced and the "Tips & Tricks" from your SIMATIC representative.

You will find more information in the manuals for the S7-200.

For further training you can attend a S7-200 course at your Siemens Training Center or with
your SIMATIC representative.

Unanswered questions?
Technical problems?

The SIMATIC representatives will be glad
to help.

Please contact the SIMATIC representative from whom you purchased the Starter Kit.
If you cannot contact your SIMATIC representative, please call the Siemens Technical
Support at:

Technical Support:

Worldwide (NUrnberg): 49 (180) 5050-222
United States (Johnson City): 1 (423) 262-2522, 1 (800) 333-7421 (USA only)
Asia/Australia (Beijing): 86 10 64 7575 75

Getting Started - Beginners
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Appendix l \

A.1  Of bits, bytes and words ...

The smallest unit of information in a digital system is known as a "bit". A bit can only have
the states "0" (false or not true) or "1" (true).

A light switch, for example, only has the states "light on" or "light off". The value of the light
switch in answer to the question "Is the light on?" is either true (the light is switched on) or
false (the light is switched off). The light switch thus has an information width of one bit. The
state "light switch on but bulb defective" is ignored in this example.

In a PLC, bits are organized into groups. A group of 8 bits is called a byte. Each bit in the
group is defined exactly by a separate position with its own address. Each bit has a byte
address and bit addresses 0 to 7. A group of 2 bytes is called a word. A group of 4 bytes is
called a double word

The numbers in this logical system are binary numbers and they are counted with the base 2
number system.

20 If this bit position is “0” (= false or untrue) it has the value 0 because
Y / 0*2°=0 (contents * value of bit position).
1 bit = I:l If this bit position is “1” (=true) it has the value 1 because 1 * 20=1

~~

This is the position of 2° in a byte !

Each bit position in the byte can have the value “1”
7 4 2 i or “0”. The bits can be used individually (e.g. as
2120 2° 20 2° 22 21 2° switches) or as a group representing a number
1 byte = | | | | | | | | | between 0 and 255.
(27+26+25+24+23+22+21+20 = 255,
20=1, 21=2, 22=4, 23=8,
24=16, 25=32, 26=64,27=128).

This is the position of the byte with the maximum value 255 in a word !

N

215 214213212211210 29 28'27 26 25 24 23 22 21 20I

twod= | [ P TPPPTPTT P T |

A word in a PLC can represent an integer number from -32768 to +32767. The bit with the
value 215 is used to denote a negative number (when position 215 has the value "1" the
number is negative).

Getting Started - Beginners
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A.2 Address areas of the S7-200

A.2 Address areas of the S7-200

The diagram below shows the memory addresses of the S7-200 PLC where inputs and
outputs are mapped. For example, if a voltage is applied to a physical input, this "1" signal is
mapped at an address in the memory that is assigned to this input. The memory areas which
form the interface with the screw terminals (inputs and outputs) of the PLC are called the
"process image of the inputs" (PIl) and the "process image of the outputs" (P1O). These
memory areas contain an image of the signals from your control process.

Address areas of an S7-200 PLC with CPU 222

Byte address
Bit address (corresponds to the
76 54 3 2 1 O(/ exponent of the bit value)

Inputs: 10.
[ — Onboard inputs (10.0 to 10.7)
1. )
2 — Address area of expansion
’ modules
13.
14, \
5 Free area in process-image input
’ table for CPU 221 (10.6 to 17.7)
115.
Bit address (corresponds to the
765 43 2 1 0 &— exponent of the bit value)
Outputs: 0.
uiputs Q Onboard outputs (Q0.0 to Q0.5)
Q1.
: — Address area of expansion
Q2. modules
Q3.

Q4. \
Free area in process-image

Q5. output table for CPU 222 (Q0.6
: to Q15.7)

Q15

Getting Started - Beginners
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A.3 Cyclic program execution in the S7-200 PLC

A.3 Cyclic program execution in the S7-200 PLC

All SIMATIC PLCs operate a scan cycle. During each cycle, the external switch states are
first read in from the inputs, and then stored in the process-image input table. The control
program is then executed on the basis of the image values. The outputs in the process-
image output table are subsequently controlled in accordance with the circuit logic of the
ladder program. The last step is to transfer the new output states from the process-image
output table to the physical outputs. This execution cycle is repeated endlessly in RUN

mode.
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